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Introduction

MATLAB is a high performance language for technical computing .It integrates computation  visualization and programming in an easy to use environment

Mat lab stands for matrix laboratory. It was written originally to provide easy access to matrix software developed by LINPACK (linear system package) and EISPACK (Eigen system package) projects.

MATLAB is therefore built on a foundation of sophisticated matrix software in which the basic element is matrix that does not require pre dimensioning
Typical uses of MATLAB
1. Math and computation

2. Algorithm development 

3. Data acquisition 

4. Data analysis ,exploration ands visualization

5. Scientific and engineering graphics

The main features of MATLAB

1. Advance algorithm for high performance numerical computation ,especially in the      

Field matrix algebra
2. A large collection of predefined mathematical functions and the ability to define one’s own functions.

3. Two-and three dimensional graphics for plotting and displaying data

4. A complete online help system

5. Powerful , matrix or vector oriented high level programming language for individual applications.

6. Toolboxes available for solving advanced problems in several application areas
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Features and capabilities of MATLAB
The MATLAB System
The MATLAB system consists of five main parts: 
Development Environment.   
This is the set of tools and facilities that help you use MATLAB functions and files. Many of these tools are graphical user interfaces. It includes the MATLAB desktop and Command Window, a command history, an editor and debugger, and browsers for viewing help, the workspace, files, and the search path. 
The MATLAB Mathematical Function Library.   
This is a vast collection of computational algorithms ranging from elementary functions, like sum, sine, cosine, and complex arithmetic, to more sophisticated functions like matrix inverse, matrix Eigen values, Bessel functions, and fast Fourier transforms. 
The MATLAB Language.  
 This is a high-level matrix/array language with control flow statements, functions, data structures, input/output, and object-oriented programming features. It allows both "programming in the small" to rapidly create quick and dirty throw-away programs, and "programming in the large" to create large and complex application programs.
 Graphics.   
MATLAB has extensive facilities for displaying vectors and matrices as graphs, as well as annotating and printing these graphs. It includes high-level functions for two-dimensional and three-dimensional data visualization, image processing, animation, and presentation graphics. It also includes low-level functions that allow you to fully customize the appearance of graphics as well as to build complete graphical user interfaces on your MATLAB applications. 
The MATLAB Application Program Interface (API).   
This is a library that allows you to write C and Fortran programs that interact with MATLAB. It includes facilities for calling routines from MATLAB (dynamic linking), calling MATLAB as a computational engine, and for reading and writing MAT-files.

 Starting MATLAB
On Windows platforms, start MATLAB by double-clicking the MATLAB shortcut icon  on your Windows desktop. On UNIX platforms, start MATLAB by typing mat lab at the operating system prompt. You can customize MATLAB startup. For example, you can change the directory in which MATLAB starts or automatically execute MATLAB statements in a script file named startup.m
MATLAB Desktop
When you start MATLAB, the MATLAB desktop appears, containing tools (graphical user interfaces) for managing files, variables, and applications associated with MATLAB. The following illustration shows the default desktop. You can customize the arrangement of tools and documents to suit your needs. For more information about the desktop tools . 
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Implementations
1. Arithmetic operations

    Entering Matrices

The best way for you to get started with MATLAB is to learn how to handle

matrices. Start MATLAB and follow along with each example.

You can enter matrices into MATLAB in several different ways:

• Enter an explicit list of elements.

• Load matrices from external data files.

• Generate matrices using built-in functions.

• Create matrices with your own functions in M-files.

Start by entering Dürer’s matrix as a list of its elements. You only have to

follow a few basic conventions:

• Separate the elements of a row with blanks or commas.

• Use a semicolon,  to indicate the end of each row.
• Surround the entire list of elements with square brackets, [ ].

To enter  matrix, simply type in the Command Window

A = [16 3 2 13; 5 10 11 8; 9 6 7 12; 4 15 14 1]

MATLAB displays the matrix you just entered:

A =

16 3 2 13

5 10 11 8

9 6 7 12

4 15 14 1

This matrix matches the numbers in the engraving. Once you have entered

the matrix, it is automatically remembered in the MATLAB workspace. You

can refer to it simply as A. Now that you have A in the workspace,
sum, transpose, and diag

You are probably already aware that the special properties of a magic square

have to do with the various ways of summing its elements. If you take the

sum along any row or column, or along either of the two main diagonals,

you will always get the same number. Let us verify that using MATLAB.

The first statement to try is

sum(A)

MATLAB replies with

ans =

34 34 34 34

When you do not specify an output variable, MATLAB uses the variable ans,

short for answer, to store the results of a calculation. You have computed a

row vector containing the sums of the columns of A. Sure enough, each of the

columns has the same sum, the magic sum, 34.

How about the row sums? MATLAB has a preference for working with the

columns of a matrix, so one way to get the row sums is to transpose the

matrix, compute the column sums of the transpose, and then transpose the
result. For an additional way that avoids the double transpose use the

dimension argument for the sum function.

MATLAB has two transpose operators. The apostrophe operator (e.g., A')

performs a complex conjugate transposition. It flips a matrix about its main

diagonal, and also changes the sign of the imaginary component of any

complex elements of the matrix. The apostrophe-dot operator (e.g., A'.),

transposes without affecting the sign of complex elements. For matrices

containing all real elements, the two operators return the same result.

So

A'

produces

ans =

16 5 9 4

3 10 6 15

2 11 7 14

13 8 12 1

and

sum(A')'

produces a column vector containing the row sums

ans =

34

34

34

34

The sum of the elements on the main diagonal is obtained with the sum and

the diag functions:

diag(A)

produces

ans =

16

10

7

1

and

sum(diag(A))

produces

ans =

34

The other diagonal, the so-called anti diagonal, is not so important

Mathematically, so MATLAB does not have a ready-made function for it.

But a function originally intended for use in graphics, fliplr, flips a matrix

From left to right:

Sum (diag(fliplr(A)))

ans =

34

You have verified that the matrix in Dürer’s engraving is indeed a magic

Square and,  in the process, have sampled a few MATLAB matrix operations.
Operators

Expressions use familiar arithmetic operators and precedence rules.

+ Addition

- Subtraction

* Multiplication

/ Division

\ Left division (described in “Matrices and Linear Algebra” in the

MATLAB documentation)

. ^ Power

' Complex conjugate transpose

( ) Specify evaluation order

Generating Matrices

MATLAB provides four functions that generate basic matrices.

zeros All zeros

ones All ones

rand Uniformly distributed random elements

randn Normally distributed random elements

Here are some examples:

Z = zeros(2,4)

Z =

0 0 0 0

0 0 0 0

F = 5*ones(3,3)

F =

5 5 5

5 5 5

5 5 5

N = fix(10*rand(1,10))

N =

9 2 6 4 8 7 4 0 8 4
R = randn(4,4)

R =

0.6353 0.0860 -0.3210 -1.2316

-0.6014 -2.0046 1.2366 1.0556

0.5512 -0.4931 -0.6313 -0.1132

-1.0998 0.4620 -2.3252 0.3792
M-Files

You can create your own matrices using M-files, which are text files containing

MATLAB  code. Use the MATLAB Editor or another text editor to create a file

Containing the same statements you would type at the MATLAB command

Line. Save the file under a name that ends in .m.

For example, create a file containing these five lines:

A = [...
16.0 3.0 2.0 13.0

5.0 10.0 11.0 8.0

9.0 6.0 7.0 12.0
4.0 15.0 14.0 1.0 ];

Store the file under the name magik.m. Then the statement

magik

reads the file and creates a variable, A, containing our example matrix.
Graph Components

MATLAB displays graphs in a special window known as a figure. To create

a graph, you need to define a coordinate system. Therefore every graph is

placed within axes, which are contained by the figure.

The actual visual representation of the data is achieved with graphics objects

like lines and surfaces. These objects are drawn within the coordinate system

defined by the axes, which MATLAB automatically creates specifically to

accommodate the range of the data. The actual data is stored as properties of

the graphics objects.
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Plotting Tools

Plotting tools are attached to figures and create an environment for creating

Graphs. These tools enable you to do the following:

• Select from a wide variety of graph types

• Change the type of graph that represents a variable
• See and set the properties of graphics objects

• Annotate graphs with text, arrows, etc.

• Create and arrange subplots in the figure

• Drag and drop data into graphs

Display the plotting tools from the View menu or by clicking the plotting tools

icon in the figure toolbar, as shown in the following picture.
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Images

Two-dimensional arrays can be displayed as images, where the array elements

determine brightness or color of the images. For example, the statements

load durer who’s Name Size Bytes Class X 648x509 2638656 double array

caption 2x28 112 char array map 128x3 3072 double array load the file durer.mat, adding three variables to the workspace. The matrix X is a 648-by-509 matrix and map is a 128-by-3 matrix that is the color map for this image.

MAT-files, such as durer.mat, are binary files that can be created on one

platform and later read by MATLAB on a different platform.

The elements of X are integers between 1 and 128, which serve as indices

into the color map , map. Then

image(X)

colormap(map)

axis image

reproduces Dürer’s etching shown at the beginning of this book. A

high-resolution scan of the magic square in the upper right corner is available

in another file. Type load detail

and then use the up arrow key on your keyboard to re execute the image,

colormap, and axis commands. The statement colormap(hot) adds some twentieth century colorization to the sixteenth century etching. The function hot generates a colormap containing shades of reds, oranges, and yellows. Typically a given image matrix has a specific colormap associated with it .

Editor/Debugger

Use the Editor/Debugger to create and debug M-files, which are programs you

write to run MATLAB functions. The Editor/Debugger provides a graphical

user interface for text editing, as well as for M-file debugging. To create or

edit an M-file use File > New or File > Open, or use the edit function.
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Implementations

1. Image processing

What is an image 

An image is represented as a two dimensional function f(x, y) where x and y are spatial co-ordinates and the amplitude of  ‘f ’ at any pair of coordinates  (x, y) is called the intensity of the image at that point . 

Gray scale image

A grayscale image is a function I(x,y) of the two spatial coordinates  of the image plane.

I(x , y) is the intensity of the image at the point (x ,y) on the image plane.

I(x,y) takes non-negative values assume the image is bounded by a rectangle [0,a]([0,b]

I: [0, a] ( [0, b] ( [0, inf )
Color image
Can be represented by three functions, R(x,y) for red, G(x,y) for green, and B(x,y) for blue.
An image may be continuous with respect to the  x and y  coordinates and also in amplitude .converting such an image to digital form requires that the coordinates as well as the amplitude to be digitized .digitizing the coordinates values is called sampling 

Digitizing the amplitude values is called quantization
Why do we process images

· Enhancement and restoration

· Remove artifacts and scratches from an old photo/movie

· Improve contrast and correct blurred images

· Transmission and storage

· Images and Video can be more effectively transmitted and stored

· Information analysis and automated recognition

· Recognizing terrorists

· Evidence

· Careful image manipulation can reveal information not present

· Detect image tampering

· Security and rights protection

· Encryption and watermarking preventing illegal content manipulation

. Compression
Color image of 600x800 pixels

Without compression
 600*800 * 24 bits/pixel = 11.52K bits = 1.44M bytes
After JPEG compression (popularly used on web)

 only 89K bytes

 compression ratio ~ 16:1
· Movie 
720x480 per frame, 30 frames/sec, 24 bits/pixel

Raw video ~ 243M bits/sec

DVD ~ about 5M bits/sec

Compression ratio ~ 48:1
Some processing techniques on image
Consider an image and display it 

i=imread('D:\abu\abbu\kartik\WIL0A.JPG');
 J = rgb2gray(i);

figure,imshow(i),figure,imshow(J)

imhist(J,32)

p = cdf('Normal',-2:2,0,1)     



image of willsmith
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Plotting its Histogram

Histogram for the image [image: image8.emf]0 50 100 150 200 250
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            Histogram equalization      

   [k,T] = histeq(J);

                  figure,plot((0:255)/255,T);
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Converting an image into a binary image

Applying thresholding technique for converting an image into a binary image

             i=imread('D:\abu\abbu\kartik\aish58_cs.jpg')

   imshow(i)

                BW = im2bw(i,0.4 );

                 imview(BW)

[image: image10.emf] [image: image11.emf]
    
Original image





Binary image

Consider a image add noise to it 

[image: image12.emf]original image
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     Original image
              
image after adding noise
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Image after mean filtering

   image after median filtering


           matlab code: 
i=imread('D:\abu\abbu\kartik\Funny86.JPG')

I = rgb2gray(i)

                  figure, imshow(I)

        J = imnoise(I,'salt & pepper',0.02); 

       figure, imshow(J)

      K = filter2(fspecial('average',3),J)/255;

      figure, imshow(K) 
      L = medfilt2(J,[3 3]);

      figure, imshow(L)
Applying Transform Techniques for image

consider an  image
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Apply Fourier transform to it
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Apply log transformation
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Apply inverse transform 
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Matlab code :





   f = zeros(30,30);

                            f(5:24,13:17) = 1;

% generating the image

                          figure,imshow(f,'notruesize')

                         F = fft2(f);


% fourier transform 

                     s =(abs(F))


% calculating its magnitude

                        imshow(s,[-1 5],'notruesize')    % plot its image





L=log(1+abs(F))

% log magnitude

                     imshow(L,[],'notruesize')

                       i=ifft2(F)


% inverse transform

                         figure,imshow(i,'notruesize')
% plot image

Blurring an image

matlab code : i=imread('D:\abu\abbu\kartik\Funny86.JPG')

I = rgb2gray(i)

figure,imshow(i)

figure,imshow(I)

figure, imhist(I)

LEN = 31;

THETA = 11;

PSF = fspecial('motion',LEN,THETA); % create PSF

Blurred = imfilter(i,PSF,'circular','conv');

figure; imshow(Blurred); title('Blurred Image');
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Blurred image

2. Speech processing

Consider a speech signal ; display the no. of samples in it ;calculate no. of epochs in it and also its Duration
a=wavread('D:\abu\abbu\david\new20 SPEAKER ECH RECOGNITION USING DECOUPLED KALMAN FILTER--111\A11.wav',[1 20])

%a=[1 2 3 7 2 3 2 8 1 -1 -3 -6 -4 4 3 2 6 1 4 2 -7 -3 -4 -5]

stem(a);

d=1;

 k=d;

zcr = 0;

for i=2:1:length(a),  

signpre=sign(a(i-1));

signpres=sign(a(i));

if(signpre*signpres == -1 ) 

    sprintf('epoch %d',zcr+1)   

   D=max(d) 

   if (D~=length(a))

    D=(D-1)+k;   

    %rot90(a(k:D))  

    (a(k:D))

    k=D+1;

else

      k=(D-k)+1;

      %rot90(a(k:D))

      (a(k:D))

  end

     d=1;   

   zcr=zcr+1    

   continue    

end   

if(signpre*signpres~=-1)

    d=d+1;       

    continue  

end

 end 

   k=(D)+1;

    sprintf('epoch %d',zcr+1)

     D=max(d)

       D=(D-1)+k;

       %rot90(a(k:D))   

    (a(k:D))
Output :

a =

    0.0113

    0.0108

    0.0096

    0.0079

    0.0073

    0.0078

    0.0069

    0.0058

    0.0026

   -0.0004

   -0.0011

   -0.0016

   -0.0013

    0.0002

    0.0004

    0.0034

    0.0068

    0.0092

    0.0103

    0.0094

ans =

epoch 1

D =

     9

ans =

    0.0113

    0.0108

    0.0096

    0.0079

    0.0073

    0.0078

    0.0069

    0.0058

    0.0026

zcr =

     1

ans =

epoch 2

D =

     4

ans =

   -0.0004

   -0.0011

   -0.0016

   -0.0013

zcr =

     2

ans =

epoch 3

D =

     7

ans =

    0.0002

    0.0004

    0.0034

    0.0068

    0.0092

    0.0103

    0.0094
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Example programs
%unit impulse
clear all;
t=-2:1:2;
y=[zeros(1,2),ones(1,1),zeros(1,2)];
subplot(2,2,1);
stem(t,y,'k','filled');
xlabel('------>t');
ylabel('------>amplitude');
title('unit impulse sequence');
%unit step
clear all;
N=input('enter the length of unit step sequence');
t=0:1:N-1;
y=ones(1,N);
subplot(2,2,2);
stem(t,y,'k','filled');
axis([0 N 0 2]);
xlabel('-------->t');
ylabel('------->amplitude');
title('unit step');
%ramp sequence
clear all;
n=input('enter the length of ramp sequence');
t=0:n-1;
y=t;

subplot(2,2,3);

stem(t,y,'k','filled');

xlabel('------->t');

ylabel('------->amplitude');

title('unit ramp sequence');

%Exponential sequence

clear all;

n=input('enter the length of exponential sequence');

t=0:n-1;

a=input('enter the value of constant term a');

y=exp(-a*t);

subplot(2,2,4);

stem(t,y,'k','filled');

xlabel('------->t');

ylabel('------->amplitude');

title('exponential sequence');
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%sinusoidal

t=0:0.01:2*pi;

y=sin(2*pi*t);

plot(t,y);

 xlabel('------->t');

 ylabel('------->amplitude');

 title('sinusoidal function');
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Operating on Matrices

%Program to find the inverse of Matrix

clc;

clear all;

n=input('enter the n value');

m=input('enter the m value');

if(n~=m)

    display('not a square matrix,inverse cannot be found')

else 

    for i=1:n,

        for j=1:n,

            A(i,j)=input('enter the elements one by one');

        end

    end

    display('given matrix A is')

    if det(A)==0

        display ('inverse cannot be found as determinant is zero')

    else

        for i=1:n,

            B=A;

            B(:,j)=[];

            B(i,:)=[];

            C=B;

            D(i,j)=((-1)^(i+j))*det(C);

        end

    end

    display('Adjoint of matrix A is')

    D

    display('inverse of matrix A is')

    Inverse=D'/det(A)

end
output:

enter the n value3

enter the m value3

enter the elements one by one1

enter the elements one by one4

enter the elements one by one5

enter the elements one by one6

enter the elements one by one7

enter the elements one by one3

enter the elements one by one2

enter the elements one by one8

enter the elements one by one6

given matrix A is

Adjoint of matrix A is

D =

     0     0    34

     0     0     0

     0     0   -17

inverse of matrix A is

Inverse =

         0         0         0

         0         0         0

    0.5000         0   -0.2500
Linear convolution

x=[1 2 3 4 5];

y=[4 3 2 1];

h=conv(x,y)
output:
h =

     4    11    20    30    40    26    14     5

Computation
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Signal processing
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